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Chapter 5.   Advice of Allotment 

A. Processing an Advice of Allotment (B4/BE) 
Document 

The Advice of Allotment document distributes budget authority by BFY, 
fund, and allotment holder. Two documents are used to record allotments 
that are identical in form and content but have different titles and 
transaction codes. One is used to record allotments for administrative 
funds and the other is used to record allotments for program funds as 
follows: 

I. Budget Execution (BE)—use for administrative funds. 

II. PAS Advice of Allotment (B4)—use for program funds. 

The following data entry instructions apply to both documents. Unique 
requirements for administrative or program funds are identified and 
explained in the description for each key field. Only the B4 document is 
shown for illustration purposes. 

1. Verify Funds with the Apportionment Query 
(APOR) 

The Apportionment Query (APOR) is used to review information 
about the status of an apportionment, including the year-to-date 
appropriated, committed, obligated, and expended amounts.  

a. The Apportionment Query (APOR) is displayed as 
follows: 

(1) Select Options from the Main menu. 

(2) Select Tables and Queries from the 
Options menu. 

(3) Click on the Category drop-down list and 
select Budget Execution. 

(4) Select the Apportionment Query (APOR). 

(5) Choose the OK button. 
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(6) Enter the last two digits of the Budget Fiscal 

Year(s) in the Budget Fiscal Year(s) field 
(for a multi-year fund, enter the last two 
digits of the beginning year and the last two 
digits of the ending year), and enter the 
fund code in the Fund field. Click on the 
search icon for a listing of valid fund codes. 

(7) Select Actions from the Main menu. 

(8) Select Display from the Actions menu. 

 
Refer to Appendix A for example of populated document.  See Example A-9.A. 
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(9) Click on the Distribution tab to view 
quarterly distributions and verify amounts 
available for allotment. The column 
headings for Quarterly Distributions are 
misnomers and should be interpreted as 
follows: 

ALLOCATION = DISTRIBUTED 
UNALLOCATED = UNDISTRIBUTED 
Additional allotments can be issued for amounts equal to or 
less than the undistributed balances. 

 

 
 

Refer to Appendix A for example of populated document.  See Example A-9.B. 
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2. Advice of Allotment (B4/BE) Document 

a. Perform the following steps to process the Advice 
of Allotment (B4/BE) document: 

(1) Select File from the Main menu. 

(2) Select New from the File Select menu. 

(3) From the Document drop-down list box, 
select PAS Advice of Allotment (B4) for 
program funds, or select Budget Execution 
(BE) for administrative funds.  

(4) Enter the Document ID.  

Note All B4 or BE document IDs referencing a no-year or multi-year fund code include 
the allotment holder (ex: CFO, HSNG, CPD, PIH, etc.) in the first field. The last 
digit of the current fiscal year, the third and fourth digit of the fund code and the # 
sign are included in the second field (Example:  CFO 0HA#). The B4 or BE 
Document ID referencing an annual fund includes the last digit of the current fiscal 
year, the last 4 digits of the Treasury symbol and the # sign in the second field 
(Example:  CFO 00143#). By entering the # sign, the system will assign the next 
available sequential number for the document ID prefix entered. 

 
 

(5) Select OK or press the Enter key. 
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b. Enter the following fields on the Header tab: 

 

Field Description 

(1) Budget Fiscal Year(s) Enter the last two digits of the Budget Fiscal Year(s). For 
a multi-year fund, enter the last two digits of the 
beginning year and the last two digits of the ending year. 

(2) Fund Enter the fund code, or click on the search icon for a 
listing of valid fund codes. 

(3) Default Line Action Defaults to Add/Activate. Ignore this default. The 
operative Default Line Action is entered on the next tab 
for Budget Line(s). 

(4) Default Transaction Types 
Approval 

Enter AP. 

(5) Default Transaction Types 
Posting 

Enter 01. 

(6) Budget Level Select Allotment Holder. 

(7) Funds Available thru 
Quarter 

Enter 1, 2, 3, or 4 for the quarter thru which funds are 
available. 

 

Refer to Appendix A for example of populated document.  See Example A-4.A. 
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c. Select the Budget Line(s) tab and enter the 
following fields: 

 
Field Description 

(1) Budget Line Action Budget Line Action defaults to Add/Activate which is to 
be used if this is the first BE or B4 document for the 
budget line. Select Change if previous documents have 
been processed for this budget line. 

(2) Budget Elements Allotment 
Holder 

Enter a valid division code to represent the allotment 
holder. Valid codes can be found on the Division Table 
(DVSN). 

(3) Distribution Quarter 
Inc/Dec  

Amounts must be entered as dollars and cents with a 
decimal. Decrease amounts must be preceded with a 
minus sign (-). Apportion all program funds in quarter 1, 
and distribute administrative funds by the applicable 
quarters. 

 

Note No data needs to be entered on the Options and Summary tabs at this budget 
level. 

(4) Select Document from the Main menu. 
(5) Select Edit from the Document menu. 
(6) View the message area at the bottom of the window for 

warning or error messages and make the necessary changes. 

Note If an error message occurs, use the Online Error Guide by double clicking on the 
error message. If unable to resolve the error with the Online Error Guide, call the 
HUDCAPS Help desk. 
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(7) Select Document from the Main menu. 
(8) Select Process from the Document menu. 
(9) When the message, “The document has been accepted, do 

you want to close the document?” appears, select Yes to 
close the document, or No to keep the document open. 

 
Refer to Appendix A for example of populated document.  See Example A-4.A. 

 

3. Advice of Allotment Query (ALOC) 

The Advice of Allotment Query (ALOC) shows the current status of 
the selected allotment budget line and is automatically updated when 
BE and B4 documents are processed. View this query after processing 
a BE/B4 document to ensure that funds have been distributed as 
intended. 

a. The Advice of Allotment Query (ALOC) is 
displayed as follows: 

(1) Select Options from the Main menu. 

(2) Select Tables and Queries from the 
Options menu. 

(3) Click on the Category drop-down list and 
select Budget Execution. 

(4) Select the Advice of Allotment Query 
(ALOC). 

(5) Choose the OK button.  
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(6) Enter the Budget Fiscal Year(s) in the 
Budget Fiscal Year(s) field (for a multi-
year fund, enter the last two digits of the 
beginning year and the last two digits of the 
ending year), the fund code in the Fund 
field and the allotment holder in the 
Allotment Holder field 

(7) Select Actions from the Main menu. 

(8) Select Display from the Actions menu. 

Refer to Appendix A for example of populated document.  See Example A-10.A. 
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(9) Click on the Distribution tab to view the 
current status of Quarterly Allotments and 
Quarterly Distributions to 
Program/Object Class. 

 
 
 

Refer to Appendix A for example of populated document.  See Example A-10.B 
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Chapter 6.   Distribution to Program/Object Class 

A. Processing a Distribution to Program/Object Class 
(B5/BE) Document 

The Distribution to Program/Object Class document distributes budget 
authority by Budget Fiscal Year (BFY), fund, allotment holder, and 
program class. Two documents are used to record distributions to 
program/object class that are identical in form and content but have 
different titles and transaction codes. One is used to record distributions to 
program/object class for administrative funds and the other is used to 
record distributions to program/object class for program funds as follows: 

I. Budget Execution (BE)—use for administrative funds. 

II. PAS Distribution to Pgm/Obj Cls (B5)—use for program 
funds. 

The following data entry instructions apply to both documents. Unique 
requirements for administrative or program funds are identified and 
explained in the description for each key field. Only the B5 document is 
shown for illustration purposes. 

 

1. Verify Fund Availability with the Advice of 
Allotment Query (ALOC) 

To verify fund availability, scan the Advice of Allotment Query 
(ALOC) before processing a Distribution to Program/Object Class 
(B5/BE) document. 

a. The Advice of Allotment Query (ALOC) is 
displayed as follows: 

(1) Select Options from the Main menu. 

(2) Select Tables and Queries from the 
Options menu. 

(3) Click on the Category drop-down list and 
select Budget Execution. 

(4) Select the Advice of Allotment Query 
(ALOC). 
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(5) Choose the OK button.  

 
 

(6) Enter the Budget Fiscal Year(s) in the 
Budget Fiscal Year(s) field (for a multi-
year fund, enter the last two digits of the 
beginning year and the last two digits of the 
ending year), the fund code in the Fund 
field, and the allotment holder in the 
Allotment Holder field. 

(7) Select Actions from the Main menu. 

(8) Select Display from the Actions menu. 

 
Refer to Appendix A for example of populated document.  See Example A-10.A. 
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(9) Click on the Distribution tab to view the 
Quarterly Distributions To Pgm/Obj Cls 
and Undistributed amounts by quarter to 
verify the amount available for further 
distribution. Additional distributions to 
program/object class can be issued for 
amounts equal to or less than the 
undistributed balance. 

 
 

Refer to Appendix A for example of populated document.  See Example A-10.B 
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2. Distribution to Program/Object Class (B5/BE) 
Document 

a. Perform the following steps to process a 
Distribution to Program/Object Class document: 

(1) Select File from the Main menu. 

(2) Select New from the File menu. 

(3) From the Document drop-down list box, 
select PAS Distribution to Pgm/Obj Cls 
(B5) for program funds, or select Budget 
Execution (BE) for administrative funds.  

(4) Enter the Document ID. 

Note All B5 or BE document IDs referencing a no-year or multi-year fund code include 
the allotment holder (ex: CFO, HSNG, CPD, PIH, etc.) in the first field. The last 
digit of the current fiscal year, the third and fourth digit of the fund code and the # 
sign are included in the second field (Example:  CFO 0HA#). The B5 or BE 
Document ID referencing an annual fund includes the last digit of the current fiscal 
year, the last 4 digits of the Treasury symbol and the # sign in the second field 
(Example:  CFO 00143#). By entering the # sign, the system will assign the next 
available sequential number for the document ID prefix entered. 

 
(5) Select OK or press the Enter key. 
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b. Enter the following fields on the Header tab: 

 
 

Field Description 

(1) Budget Fiscal Year(s) Enter the last two digits of the Budget Fiscal Year(s). 
For a multi-year fund, enter the last two digits of the 
beginning year and the last two digits of the ending 
year. 

(2) Fund Enter the fund code, or click on the search icon for a 
listing of valid fund codes. 

(3) Default Line Action Default Line Action defaults to Add/Activate. Ignore 
this default. The operative Default Line Action is 
entered on the next tab for Budget Line(s). 

(4) Default Transaction Types 
Approval 

Enter AP. 

(5) Default Transaction Types 
Posting 

Enter 01. 

(6) Budget Level Select Pgm/Obj Cls. 

(7) Funds Available thru Quarter Enter 1, 2, 3, or 4 for the quarter thru which funds are 
available. 

 

Refer to Appendix A for example of populated document.  See Example A-5.A. 
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c. Select the Budget Line(s) tab and enter the 
following fields: 

 
 

Field Description 

 Budget Line Action Budget Line Action defaults to Add/Activate which is 
to be used if this is the first BE or B5 document for this 
budget line. Select Change if previous documents 
have been processed for this budget line.  

 Budget Elements Allotment 
Holder 

Enter a valid division code to represent the allotment 
holder. Valid codes can be found on the Division Table 
(DVSN). 

 Budget Elements Pgm/Obj Cls Enter the appropriate program class code. Valid codes 
can be found on the Program Class Table (PCLS). 

 Distribution Quarter Inc/Dec  Amounts must be entered as dollars and cents with a 
decimal. Decrease amounts must be preceded with a 
minus sign (-). Apportion all program funds in quarter 
1, and distribute administrative funds by the applicable 
quarters. 

 

Refer to Appendix A for example of populated document.  See Example A-5.A. 

 

Note No data needs to be entered on the Options and Summary tabs at this budget level. 

(5) Select Document from the Main menu. 
(6) Select Edit from the Document menu. 
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(7) View the message area at the bottom of the window for 
warning or error messages and make the necessary changes. 

 

Note If an error message occurs, use the Online Error Guide by double clicking on the 
error message. If unable to resolve the error with the Online Error Guide, call the 
HUDCAPS Help desk. 

(8) Select Document from the Main menu. 
(9) Select Process from the Document menu. 
(10) When the  message, “The document has been accepted, do 

you want to close the document?” appears, select Yes to 
close the document, or No to keep the document open. 

 

3. Distribution to Program/Object Class Query (SALC) 

The Distribution to Pgm/Obj Query (SALC) shows the currents status 
of the selected distribution to program/object class budget line and is 
automatically updated when BE and B5 documents are processed. 
View this query after processing a BE/B5 document to ensure that 
funds have been distributed as intended. 

a. The Distribution to Pgm/Obj Cls Query (SALC) is 
displayed as follows: 

(1) Select Options from the Main menu. 

(2) Select Tables and Queries from the 
Options menu. 

(3) Click on the Category drop-down list and 
select Budget Execution. 

(4) Select the Distribution to Pgm/Obj Cls 
Query (SALC). 

(5) Choose the OK button. 
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(6) Enter the Budget Fiscal Year(s) in the 

Budget Fiscal Year(s) field (for a multi-
year fund, enter the last two digits of the 
beginning year and the last two digits of the 
ending year), the fund code in the Fund 
field, the allotment holder in the Allotment 
Holder field, and the program code in the 
Pgm/Obj Cls field. 

(7) Select Actions from the Main menu. 

(8) Select Display from the Actions menu. 

Refer to Appendix A for example of populated document.  See Example A-11.A 
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(9) Click on the Distribution tab to view the 
current status of Quarterly Distribution To 
Pgm/Obj Cls and Quarterly Distributions 
To Program. 

 
 

Refer to Appendix A for example of populated document.  See Example A-11.B. 
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Chapter 7.   Distribution to Program 

A. Processing a Distribution to Program (B6/BE) 
Document 

The Distribution to Program document distributes budget authority by 
Budget Fiscal Year (BFY), fund, allotment holder, program/object class, 
and program. Two documents are used to record distributions to program 
that are identical in form and content but have different titles and 
transaction codes. One is used to record distributions to program for 
administrative funds and the other is used to record distributions to 
program for program funds as follows: 

I. Budget Execution (BE)—use for administrative funds. 

II. PAS Distribution to Program (B6)—use for program funds. 

The following data entry instructions apply to both documents. Unique 
requirements for administrative or program funds are identified and 
explained in the description for each key field. Only the B6 document is 
shown for illustration purposes.  

 

1. Verify Fund Availability with the Distribution to 
Pgm/Obj Cls Query (SALC) 

To verify fund availability, scan the Distribution to Pgm/Obj Cls 
Query (SALC) before processing a Distribution to Program. 

The Distribution to Pgm/Obj Cls Query (SALC) is used to review 
information about the status of a suballocation, including the 
suballocated, committed, obligated, and expended amounts. 

a. The Distribution to Pgm/Obj Cls Query (SALC) is 
displayed as follows: 

(1) Select Options from the Main menu. 

(2) Select Tables and Queries from the 
Options menu. 

(3) Click on the Category drop-down list and 
select Budget Execution. 
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(4) Select the Distribution to Pgm/Obj Cls 
Query (SALC). 

(5) Choose the OK button. 

 
 

(6) Enter the Budget Fiscal Year(s) in the 
Budget Fiscal Year(s) field (for a multi-
year fund, enter the last two digits of the 
beginning year and the last two digits of the 
ending year), the Fund Code in the Fund 
field, the allotment holder in the Allotment 
Holder field, and the program code in the 
Pgm/Obj Cls field. 

(7) Select Actions from the Main menu. 

(8) Select Display from the Actions menu. 

Refer to Appendix A for example of populated document.  See Example A-11.A 
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(9) Click on the Distribution tab to view the 
Quarterly Distributions To Program and 
Undistributed amounts by quarter to verify 
the amount available for further 
distribution. Additional distributions to 
program can be issued for amounts equal to 
or less than the undistributed balances. 

 
 

Refer to Appendix A for example of populated document.  See Example A-11.B. 
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2. Distribution to Program (B6/BE) Document 

a. Perform the following steps to process a 
Distribution to Program document: 

(1) Select File from the Main menu. 

(2) Select New from the File menu. 

(3) From the Document Type drop-down list, 
select PAS Distribution to Program (B6) 
for program funds, or select Budget 
Execution (BE) for administrative funds. 

(4) Enter the Document ID. 

Note All B6 or BE document IDs referencing a no-year or multi-year fund code include 
the allotment holder (ex: CFO, HSNG, CPD, PIH, etc.) in the first field. The last 
digit of the current fiscal year, the third and fourth digit of the fund code and the # 
sign are included in the second field (Example:  HSNG 0HA#). The B6 or BE 
Document ID referencing an annual fund includes the last digit of the current fiscal 
year, the last 4 digits of the Treasury symbol and the # sign in the second field 
(Example:  CFO 00143#). By entering the # sign, the system will assign the next 
available sequential number for the document ID prefix entered. 

 
 

(5) Select OK or press the Enter key. 
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b. Enter the following fields on the Header tab: 

 
 

Field Description 

 Budget Fiscal Year(s) Enter the last two digits of the Budget Fiscal Year(s). 
For a multi-year fund, enter the last two digits of the 
beginning year and the last two digits of the ending 
year. 

 Fund Enter the fund code, or click on the search icon for a 
listing of valid fund codes. 

 Default Line Action Default Line Action defaults to Add/Activate. Ignore 
this default. The operative Default Line Action is 
entered on the next tab for Budget Line(s). 

 Default Transaction Types 
Approval 

Enter AP. 

 Default Transaction Types 
Posting 

Enter 01. 

 Budget Level Select Program. 

 Funds Available thru Quarter Enter 1, 2, 3, or 4 for the quarter thru which funds are 
available. 

 

Refer to Appendix A for example of populated document.  See Example A-6.A 
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c. Select the Budget Line(s) tab and enter the 
following fields: 

 
 

Field Description 

(1) Budget Line Action Budget Line Action defaults to Add/Activate which is 
to be used if this is the first BE or B6 document for this 
budget line. Select Change if previous documents 
have been processed for this budget line. 

(2) Budget Elements Allotment 
Holder 

Enter a valid division code to represent the allotment 
holder. Valid codes can be found on the Division Table 
(DVSN). 

(3) Budget Elements Pgm/Obj Cls Enter the appropriate program code. Valid codes can 
be found on the Program Table (PGMT). 

(4) Distribution Quarter Inc/Dec  Amounts must be entered as dollars and cents with a 
decimal. Decrease amounts must be preceded with a 
minus sign (-). Apportion all program funds in quarter 
1, and distribute administrative funds by the applicable 
quarters.  

 

Refer to Appendix A for example of populated document.  See Example A-6.A 
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d. Select the Options tab and select the following 
fields: 

 
 

Field Description 

(1) Assign by Organization Select Yes. 

(2) Assign by Pgm/Obj Cls Select Yes. 

(3) Assign by Object Code Select Yes or No at the discretion of the recipient of 
the Distribution to Program. 

(4) Assignment/Operating Budget 
Spending Controls 

Select Full. 

 

Refer to Appendix A for example of populated document.  See Example A-6.A 

Note No data needs to be entered on the Summary tab.

(5) Select Document from the Main menu. 
(6) Select Edit from the Document menu. 
(7) View the message area at the bottom of the window for 

warning or error messages and make the necessary changes. 
 

Note If an error message occurs, use the Online Error Guide by double clicking on the 
error message. If unable to resolve the error with the Online Error Guide, call the 
HUDCAPS Help desk. 
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(8) Select Document from the Main menu.  
(9) Select Process from the Document menu. 
(10) When the message, “The document has been accepted, do 

you want to close the document?” appears, select Yes to 
close the document, or No to keep it open. 

 
3. Distribution to Program Query (ALLT) 

The Distribution to Program Query (ALLT) shows the current status of 
the selected program budget line and is automatically updated when 
BE and B6 documents are processed. View this query after processing 
a BE/B6 document to ensure that funds have been distributed as 
intended. 

a. The Distribution to Program Query (ALLT) is 
displayed as follows: 

(1) Select Options from the Main menu. 

(2) Select Tables and Queries from the 
Options menu. 

(3) Click on the Category drop-down list and 
select Budget Execution. 

(4) Select the Distribution to Program Query 
(ALLT). 

(5) Choose the OK button. 
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(6) Enter the Budget Fiscal Year(s) in the 
Budget Fiscal Year(s) field (for a multi-
year fund, enter the last two digits of the 
beginning year and the last two digits of the 
ending year), the fund code in the Fund 
field the allotment holder in the Allotment 
Holder field, and the program code in the 
Pgm/Obj Cls field. 

(7) Select Actions from the Main menu. 

(8) Select Display from the Actions menu. 

 
Refer to Appendix A for example of populated document.  See Example A-12.A 
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(9) Click on the Distribution tab to view the 
current status of quarterly Distribution to 
Program and Quarterly Distributions to 
Assignment/Operating Budget. 

 
 

Refer to Appendix A for example of populated document.  See Example A-12.B. 
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